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INTRODUCTION
Thank you for purchasing HP Tuners   products.

All of our hardware and software designs undergo rigorous testing to provide   years of 
trouble free service. All products are individually tested   before they ship to ensure 
you receive a working product. Please   read all of the associated documentation to get 
the most out of   your unit. We hope you enjoy using VCM Suite.

￭ What is VCM Suite? (Page 5)

￭ What is a VCM? (Page 8)      

WHAT IS VCM SUITE?
Typical late model vehicles use computers to control all aspects     of engine operation 
(and in many cases, transmission operation). For such vehicles, VCM Suite is a com-
prehensive tuning tool that allows performance tuning and diagnostics, whether you 
want to increase the fuel economy of your daily driver or maximize your performance 
on the race track. 

The suite has two components:

￭ VCM Editor allows users to adjust many of the parameters that control the 
operation of the engine and transmission.

￭ VCM Scanner allows users to monitor, log, and review key data that provides 
insight into the effectiveness of the vehicle's current tune. With such insight, a 
skil led tuner can return to VCM Editor and further refine the tune.
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VCM EDITOR

VCM Editor allows the user to adjust a broad variety of engine and transmission 
parameters. Those     familiar with any form of engine and transmission tuning will 
already     understand the relevance of parameters such as:

￭ Ignition timing

￭ Fuel curve (Air Fuel Ratio)

￭ Fuel Injector sizes

￭ Mass Airflow sensor (MAF)

￭ Volumetric Efficiency

￭ Idle control

￭ Automatic transmission shift speeds

￭ Automatic transmission shift pressures

However, the modern vehicle controller also includes various      protection mechanisms 
designed to prevent abuse and premature      component failure. These items are of l ittle 
value in a racing      application and some folks are quite surprised to find out they     even 
exist. Some examples are:

￭ RPM limiters

￭ Speed limiters

￭ Torque reduction during transmission shifts

￭ Various engine and transmission abuse modes

￭ Electronic throttle (fly by wire) torque management

￭ Over boost protection

￭ Fuel octane learning

￭ Various transmission torque limits

In addition, VCM Editor does not overlook the simple      (and often forgotten) things such 
as changing cooling fan      operation, recalibration of speedometer for final drive ratio      
changes, and disabling of anti-theft systems for retro installs.
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VCM SCANNER

Knowing what to      change is only half the story. Being able to accurately and      con-
veniently record key data that reflects the current tune is      paramount to any tuner's 
ability to extract that extra bit of performance.      

VCM Scanner's comprehensive scanning capabilities allow      you to record important 
parameters while the engine is running. Data, such as RPM, spark advance, inlet air 
temperature,     and  coolant temperatures can be logged, saved and reviewed      to 
determine how well the current tune is functioning. 

However, VCM Scanner is not limited to data that can be collected through the 

vehicle's diagnostic port. When used with an  MPVI2/2+ with the Pro Feature Set or with 
an MPVI Pro, VCM Scanner can incorporate Wideband O2 , Exhaust Gas      Temperature, 
and other sensor output directly into the data stream.

Additionally, VCM Scanner can be used for a variety of diagnostic functions such as 
reading DTCs, checking for misfires, and making sure sensors are functioning and 
reading correctly.
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WHAT IS A VCM?
Vehicle Control Module (VCM)

The VCM Suite and this document use the term Vehicle Control Module (VCM) to   mean 
the computer that is primarily responsible for engine   and transmission operation. In 
some vehicles, there are actually two   modules, an Engine Control Module (ECM) and a 
Transmission Control   Module (TCM). In general, the number of modules required to 
be read   or written will be transparent to the end user or become obvious   during the 
read/write process.

In certain applications, VCM Editor supports configuring the following additional 
modules:

￭ Fuel System Control Module (FSCM)

￭ Fuel Injection Control Module (FICM)

￭ Body Control module (BCM)

Most vehicles also contain many other modules that control    different aspects of the 
vehicle's operation. At this time, VCM Suite    does not allow modification of these other 
modules. Some   examples are:

￭ Anti-lock Braking System (ABS) module

￭ Instrument Panel Cluster (IPC)

￭ Active Handling module

￭ Radio module

￭ Heater, Ventilation and Air Conditioning (HVAC) module

￭ Navigation system module
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OVERVIEW
Follow these steps to get started with the VCM Suite:

1. If you don't already have an account on hptuners.com, create one now .

2. Download and install the VCM Suite. See Installing The Software (Page 12) for more 
information.

3. The VCM Suite connects to vehicles using an interface device from HP Tuners. If 
you do not already have such a device, follow these steps to obtain one and 
prepare it for use:

a. Purchase a device. See Obtaining A New Interface Device (Page 39) for more 
information.

b. When you receive the device, prepare it for use. See Preparing a New Interface 
Device for Use (Page 43).

c. Register the device at hptuners.com. See Registering Your Interface Device 
(Page 46).

NOTE: Certain vehicles may require modifications to their VCM or special 
cables to allow reading and writing of tuning files. See Manufacturer Locked 
Control Modules (Page 50).

4. Before you get started tuning vehicles, you may want to familiarize yourself with 
our licensing system. The VCM Suite is l icensed on a "pay as you go" basis. You will 
only need to pay for the vehicles you actually tune and payment is not required 
until you flash your changes back to the vehicle. See the following topics for more 
information:

￭ Licensing Vehicles (Page 15)

￭ Credits (Page 20)

5. When you are ready to begin tuning, ALWAYS check the vehicle for diagnostic 
trouble codes (DTCs)  before you do anything else. If there is a mechanical issue 
with the vehicle, it may affect performance and any performance data you want to 
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monitor could be impacted. This makes it very difficult to tune the vehicle 
effectively. See Reading and Clearing DTCs (Page 53) for instructions.

IMPORTANT: Reading a vehicle will clear all DTCs, resulting in the loss of the 
troubleshooting information they contain. DO NOT proceed to the next step 
until you have resolved as many DTCs as possible and made note of those 
issues that cannot be resolved. 

6. Once you have resolved as many DTCs  as possible, the next step is usually to read  
of the vehicle's current sensor output using VCM Scanner. Obtaining this "data log" 
will often provide valuable information in understanding the vehicle's current 
behavior.

7. In VCM Editor, read the current tune of the of the vehicle. See Reading a Vehicle 
(Page 56) for instructions.

CAUTION: Improperly tuning a vehicle can cause serious engine damage. 
Do not attempt to make any change to a vehicle's tune without 
thoroughly researching the potential impacts of the change.

8. Tune the vehicle. This process usually has the following steps:

a. Edit the tune file using VCM Editor. 

b. Write the modified tune file back to the vehicle. 

c. Use VCM Scanner to check the impact of your changes and verify that all 
performance and emissions characteristics of the vehicle remain within limits 
acceptable to the vehicle owner and required by law.

d. Repeat steps a through c until your desired tuning goals have been met.
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CREATING AN ACCOUNT
If you do not already have an HP Tuners account, create one now:

1. Go to https://www.hptuners.com/my-account/ .

2. The My Account page appears. Click the Sign up now l ink at the bottom of the 
page.

3. The My Account Sign Up Page appears. Enter your email address and click Send 
Code . A verification code will be sent to the email address entered.

4. Once you receive the code, enter the verification code in the space provided and 
fil l out the remaining fields on the page.

5. Click Create .
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INSTALLING THE SOFTWARE
The VCM Suite is a free download that can be installed on as may computers as you 
like without additional charges.

SYSTEM REQUIREMENTS
The VCM Suite is designed to be resource-friendly, suitable for desktop PCs and 
laptops. However, these applications are also capable of complex mathematic com-
putations. In some cases, resource demand and battery usage will increase.

￭ 2 GHz x86 CPU (ARM processors are NOT supported)

￭ 4 GB RAM

￭ Microsoft Windows 7 or newer running on Windows-based PC or laptop. (Running 
Windows on Mac or Linux computers is NOT supported)

￭ Microsoft .NET Framework 4.6.1

INSTALLATION INSTRUCTIONS
Follow these steps to install the latest version of the VCM Suite on your computer:

1. Navigate to https://www.hptuners.com/downloads/ .

2. Select the icon shown below to download the latest stable version of the VCM 
Suite.
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NOTE: The Downloads page also has a similar panel that downloads the latest 
BETA version of the VCM Suite. The beta is useful when you want to work on a 
vehicle we've recently added support for or you need to use a feature that is 
relatively new.

NOTE: The stable version and the beta can both be installed on the same 
computer. Both versions will peacefully co-exist on the same PC without 
interfering with one another.

3. Open the downloaded file. The installation wizard will appear.

4. Follow the instructions on screen to complete software installation.
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ADDING SHORTCUTS
The installer does not put shortcuts on your computer's desktop. If you wish to add a 
them, follow these steps:

1. Navigate to the folder in which VCM Suite was installed:

￭ VCM Suite is found in: C:\Program Files (x86)\HP Tuners\VCM Suite

￭ VCM Suite BETA is found in: C:\Program Files (x86)\HP Tuners\VCM Suite (Beta)

2. Right-click on either the VCM Editor icon or the VCM Scanner icon and drag it to 
your desktop. A popup menu appears.

3. Select Create shortcuts here .

NOTE: DO NOT move these icons out of the installation folder. The software 
will no longer function if you do so.
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LICENSING VEHICLES
The VCM Suite is l icensed based on the vehicles you are actually tuning (or plan to 
tune in the future). A license is tied to a vehicle's VIN, as well as the serial number and 
operating system version of its VCM.

A separate license will be required for each HP Tuners interface device you use to 
flash vehicles. Vehicles that are not licensed on a particular interface device cannot be 
flashed by that device.

Currently, two types of l icense can be purchased:

￭ A Single Vehicle License  allows you to tune the individual vehicle which has been 
licensed. This is l ikely the best option for a small tuner shop or enthusiast that is 
tuning a very small number of vehicles.

NOTE: For some vehicles, you will be offered the option to license the ECM and 
TCM separately, rather than licensing the whole vehicle. 

￭ For some vehicle models, a Year/Model l icense can be purchased. These licenses 
allow you to tune an unlimited number of vehicles with the same model, year, and 
engine. This is l ikely a good option for tuner shops that handle a significant number 
of vehicles of the same model and vintage.

Licenses for additional vehicles can be purchased at any time. Moreover, if a 
Year/Model l icense is available for the vehicle you are licensing, the purchase of the 

Single Vehicle License will earn upgrade credits , which can be applied to the 
purchase of the Year/Model l icense.

PURCHASING A LICENSE
If you do not yet have a license that covers the vehicle you are working on, the 
software will prompt you to purchase a license when you attempt to flash those 
changes to the vehicle. See License Activation Rules (Page 17) for more detail on 
licensing requirements.
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The prompt the software displays looks like this:

NOTE: Prices for licenses are listed in credits. Credits are the currency HP Tuners 
uses for license transactions. See Credits (Page 20) for more information.

Choose the desired option and click the Ok button. The appropriate amount of credits 

will be deducted from the credits on your MPVI2/2+.
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HOW MANY CREDITS DO I NEED?
The number of credits required to license a particular vehicle depends on the vehicle. 
Some vehicles require more credits than others. Most single vehicle licenses require 

between 2 and 6 credits.

Additionally, purchasing a license for all vehicles of the same model and year requires 
more credits than a single vehicle license. But, its price can be reduced by earning 

upgrade credits .

For a list of specific credit requirements by make and model, see the Supported 
Vehicles page.

CAN I DELETE LICENSES OR SWAP THEM FOR ANOTHER VEHICLE?
No. Once licenses are chosen and committed, they are permanently stored and 
cannot be erased or swapped.

LICENSE ACTIVATION RULES
You can open, view, and modify any file supported by HP Tuners, whether you have a 
license for the vehicle or not.

If you do not already have a license that covers the vehicle you are working on, you 
will be prompted to purchase a license the first time you attempt to write a tune to 
that vehicle.

NOTE: Older (pre-MPVI2) devices also required the vehicle to be licensed prior to 
saving a modified file on your PC. This is not required with MPVI2/2+/3. devices.

The rules are as follows:

￭ Every HP Tuners interface device must have its own license for each vehicle 
you flash with that device.

￭ The vehicle used for the original read your tune is based on must be licensed. This 
license is tied not only the vehicle's VIN, but also to the serial number and 
operating system version of its VCM.

Page 17

https://www.hptuners.com/vehicles/
https://www.hptuners.com/vehicles/


VCM SUITE GETTING STARTED GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

￭ If you are writing to a different vehicle, you will need a license that covers that 
vehicle, even if the vehicle is otherwise identical to the vehicle used for the original 
read. (The new vehicle will stil l have a different VIN and its VCM will have a different 
serial number.)

￭ If you change the VCM installed in the vehicle to be flashed, you will need a license 
that covers the new VCM. (The new VCM will have a different serial number than 
the original.)

￭ If you load a different operating system version on the VCM, you will sometimes be 
prompted to license the new operating system. However, if you apply a custom 
operating system from HP Tuners, you will typically not be required to license the 
custom OS as long as you license the base vehicle BEFORE you attempt to apply the 
custom OS.

￭ It 's possible to change the VIN for certain vehicles. If you do this, you may be 
required to license the additional VIN.

TYPICAL VEHICLE LICENSING

In practice, l icensing prompts appear very infrequently. For example:

￭ When working with your own vehicle, you will almost always read the vehicle first. 
The read and any modifications you make to the read file do not require a license.

￭ The first time you write a tune to a particular vehicle, you will be required to 
purchase the required license(s).

￭ Once purchased, you have all the licenses needed for your vehicle. This allows you 
to flash the same vehicle an unlimited number of times without seeing another 
prompt.

￭ If you later apply changes to the vehicle that would change the VIN, the PCM or the 
version of the PCM operating system, you may receive additional l icensing 
prompts.
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TAKE CAUTION WHEN

The following cases are extreme tests of our licensing rules. To avoid having to 
purchase multiple licenses for the same vehicle, think carefully before you proceed.

DOWNLOADED TUNE FILES

Although viewing tune files downloaded from the Internet can sometimes be very 
helpful when you're learning to tune, flashing these files to a vehicle is 
NOT recommended.

If you try to write such a file to your vehicle, you will be prompted to purchase a 
license for the vehicle that fi le was read from when you attempt to write the file to 
your vehicle.

If you have not yet licensed your own vehicle, you will be prompted to license your 
vehicle as well.

Additionally, you may be prompted to license the new VIN/OS combination.

ADDITIONAL / REPLACEMENT VCMS

Single vehicle licenses are tied to both VIN and VCM. If you purchase a spare VCM for 
your vehicle, you will need an additional l icense for the spare VCM when you try to 
write to it.

However, If the spare VCM is same year and model as a year/model l icense which you 
already have, you will not be prompted to license the spare. You will already have a 
license that supports that VCM.
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CREDITS
Credits are the currency HP Tuners uses to sell licenses for tuning specific vehicles. 

When purchased, credits are loaded onto the HP Tuners interface device you use 
to read and flash vehicles. Newer devices, such as the MPVI2 , 2+, and 3 employ 
universal credits, which can be used for any vehicle we support.

Older MPVI units used a different type of credit for each vehicle manufacturer. Those 
credits are stil l valid and will be accepted if they have not yet been used.

ADDING CREDITS
To purchase new credits and add them to your device:

1. If you have not already done so, create an account on www.hptuners.com and 
register your interface device .

2. Once registered, the module will appear in your My Devices list. Select My Devices 
on the My Account page.
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3. The My Devices page lists all of your registered devices. Select the Add Credit l ink 
for the desired device.

4. In the box to the left of the Add to cart button, enter the number of credits you 
wish to purchase.

5. Click Add to cart and proceed to checkout.

6. Once checkout is completed, connect the device to a USB port on your computer. 
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7. Open VCM Scanner or VCM Editor.

8. In the menu bar, select Help > Resync Interface . This ensures that information 
about your interface, its credits and its l icenses are available to both the VCM Suite 
and the device itself.

9. When the resync is completed, click Close .
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HOW MANY CREDITS DO I HAVE NOW?
There are two places to see available credits:

￭ VCM Suite Info (the Infolog)

￭ The My Account page on the HP Tuners website.

NOTE: You can view the number of credits spent on licenses and the number of 
upgrade credits available in the VCM Editor's License Information window. 

VIEWING CREDITS IN THE INFOLOG

The number of available credits can be seen in the VCM Suite Info window:

1. Click the VCM Suite Info button in either VCM Editor or VCM Scanner.

NOTE: make sure your interface is plugged into your PC before proceeding. 

2. Click the blue circle "i " icon to poll the software and the vehicle. 
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NOTE: This step may take five to twenty seconds to complete.

3. When Infolog generation is complete, the number of credits on the attached 
interface can be seen near the top of the file.
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VIEWING CREDITS ON THE MY ACCOUNT PAGE

1. Navigate to the My Account page at https://www.hptuners.com/my-account/ .

2. Select the My Devices tab.

3. The interface devices you have registered are listed on this page by serial number. 
The number of credits that have been loaded onto each device is displayed directly 
to the right of the device's serial number.

Page 25

https://www.hptuners.com/my-account/


VCM SUITE GETTING STARTED GUIDE

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

UPGRADE CREDITS
For vehicle models that have a Year/Model l icense available, each purchase of a Single 
Vehicle  l icense will earn "upgrade credits" that count towards the purchase of the 
Year/Model l icense:

For these models, 75% of the credits used to purchase a Single Vehicle License will 
count towards an upgrade to a Year/Model l icense for the same vehicle. For example, 

75% of the credits spent on a 2001 Camaro Single Vehicle license count towards an 
upgrade to a 2001 Camaro Year/Model l icense.

This combination of lower tier license availability and discounted upgrades provides 
customers a relatively low cost entry point while protecting that investment for future 
growth. 

Upgrade credits are applied automatically. When you are prompted to license a new 
vehicle, the reduced number of credits will be displayed for the higher tier license. It is 
possible to reduce the number of credits required to purchase the Year/Model l icense 
to zero.
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EXAMPLE 1

In this example, a customer does the following things:

1. Uses 4 credits to license two Fbody single vehicles that are model year 2000 .

75% of these 4 credits count towards an upgrade to license for all model year 2000 
Fbody vehicles. So, they are added together, then multiplied by 75%, which yields 3 
Upgrade Credits.

Since the 2000 Fbody Year/Model l icense normally costs 6 credits, it is now 
reduced to 3 because of the customer's 3 upgrade credits. The calculation of this is 
completely automatic. All the customer will notice is the reduced number of 
credits on the licensing form.
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2. The customer then decides to purchase the 2000 Fbody Year/Model l icense at the 
reduced 3 credit price. 

3. The customer then purchases the 2001 and 2002 Fbody Year/Model l icenses for 6 
credits each. 

NOTE: Since all available upgrade credits had already been used by the 
previous purchase, these new purchases are recorded at the full price of 6 
credits each. 
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EXAMPLE 2

This example shows a small tuner shop or weekend tuner using upgrade credits to 
take advantage of the lower entry point while protecting their investment. In this 
example, the customer was an existing HPT customer with Year/Model l icenses for 

1999 , 2000 , and 2001 Fbody vehicles.

1. The customer upgrades from Serial to MPVI Pro. Existing licenses are transferred at 
6 credits each.

2. Then, the tuner is faced with a decision. He has a customer who wants a 2004 GTO 
tune, but he's not sure how many more 2004 Ghats he's going to get. So, he 
decides to take the Single Vehicle option for 2 credits on this one and "see how it 
goes".
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3. Six months pass and the tuner receives another 2004 GTO request. The tuner 
thinks it 's been 6 months since the last one, so he will just do the same thing. 

NOTE: At this point, the software would have prompted him with a cost of 5 
credits to upgrade to the 2004 GTO Year/Model (since 2 x 75% = 1 upgrade 
credit).

4. Another few months pass and the tuner receives a third 2004 GTO request. The 
tuner thinks he has only done two of these and it 's cost him $199 for the two single 
vehicles, he is stil l $100 ahead over the last nine months compared to the 2004 
GTO Year/Model at $299 . At this point, the software would be prompting him to 
purchase 3 credits to upgrade to the 2004 GTO Year/Model (since 4 x 75% = 3 
upgrade credits). The tuner decides to go the Single Vehicle route again happy that 
he is doing the right thing.

5. After another few months, the tuner receives a fourth 2004 GTO request. This 
time, the tuner sees the software is prompting him to purchase 2 credits to 
upgrade to the 2004 GTO Year/Model (since 6 x 75% = 4 upgrade credits). The 
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tuner then decides he would be crazy not to take the 2004 GTO Year/Model option 
for 2 credits. He thinks back over the last year and realizes sure he has paid $99 
more than if he had taken the risk initially on the 2004 GTO Year/Model l icense. 
But, given the length of time that has passed, it is of no concern. He would have 
been much worse off had he purchased the Year/Model up front and never tuned 

another 2004 GTO!

6. The Year/Model upgrade purchase  is recorded at the reduced price of 2 credits, 
which is now the tuner's actual purchase price to license the 2004 GTO 
Year/Model.
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REVIEWING AVAILABLE UPGRADE CREDITS

To review your available Upgrade Credits: 

1. Open VCM Editor.

2. In the Help menu, select License Information . The License Information window 
appears.

3. Select the License Upgrade Paths tab. You will see the upgrade credits you have 
and how many additional credits are required for the license.

Page 32



INTERFACE DEVICES

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

INTERFACE DEVICES
When using the VCM Suite to read information from a vehicle or write tunes to a 
vehicle, you will need to connect your computer to the vehicle. This requires an 
"interface device" that translates the many languages (protocols) used by vehicle on-
board computing systems into the single language (protocol) used by HP Tuners 
software. 

There are two current interface devices:

￭ MPVI3

￭ RTD Gen 3

Additionally, a number of older interface devices , such as the MPVI, MPVI2 , and 
MPVI2+ are stil l supported by VCM Suite. However, these devices do not support the 
full range of features of the MPVI3 .

MPVI3

This is our most recent interface device designed spe-
cifically for tuners. It supports the full range of features 
of the VCM Suite and the full range of features of the 
TDN app for mobile devices. Plus, it includes twice the 

storage of the MPVI2+ and a faster processor. 
Moreover, this device now includes a built in high-
resolution accelerometer.

Pro Feature Set is now standard with this interface, 
but if you want to attach external inputs, you will need 
to purchase a Pro Link+ cable separately. External 
sensor inputs can often provide valuable insight into 
what's going on under the hood.
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RTD GEN 3

Tuners sometimes provide this device to their 
customers so that the customer can read tuning files 
from their own vehicle. This allows the customer to 
exchange these files with their preferred tuner, who is 
then able to adjust the vehicle's tune and monitor its 
performance remotely.

These devices fully support the TDN app, which is the 
recommended software for users of these devices. 
Users who are interested in the powerful data logging 
features of VCM Scanner will find that application to be 

fully functional with RTD Gen 3 as well.

However, use of VCM Editor is NOT supported by this 
device. This helps prevent the tuner's customers from 
altering the tuner's enhancements.

When used with the Pro Feature Set (including the 
Pro Link+), the RTD Gen 3 allows users to attach 
additional sensor inputs, which may provide valuable 
insight into what's going on under the hood.

In North America, This device is only available via direct 
sale to select, high volume tuning customers. Devices 
sold this way typically carry the tuner's company brand. 
They are not sold under the HP Tuners brand.
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OLDER INTERFACE DEVICES
The interface devices used by HP Tuners applications have evolved over time. 
Although we always recommend using the latest generation of interface device 

(currently the MPVI3), several older generations stil l exist in the field. Depending on 
their age, these devices may remain fully functional with newer releases of the VCM 
Suite:

￭ MPVI2+ (4th generation tuner interface)

￭ RTD+ (2nd generation end user interface)

￭ MPVI2 (3rd generation tuner interface)

￭ RTD (1st generation end user interface)

￭ MPVI (2nd generation tuner interface)

￭ Serial Interface (our 1st generation tuner interface)

MPVI2+

This interface is nearly identical to the current 
generation of devices. It featured faster Bluetooth® and 
USB connections than any of our previous interface 
devices and included a more robust screw on 
connector for additional inputs.

However, it did not have as much storage as newer 
devices and it lacked the high-resolution accel-
erometer.

When used with the optional Pro Feature Set 
(including the Pro Link+), the MPVI2+ allows tuners to 
attach additional sensor inputs, which may provide 
valuable insight into what's going on under the hood.
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RTD+

This is the second generation of our RTD series. These 
devices are for vehicle owners and vehicle technicians 
who are using a third party to tune vehicles rather than 
tuning vehicles themselves. 

NOTE: These devices are the same generation as 
the MPVI2+. They're just intended for a different 
group of users.

These devices fully support the TDN app, which is the 
recommended software for users of these devices. 
Users who are interested in the powerful data logging 
features of VCM Scanner will find that application to be 
fully functional with RTD+ as well.

However, use of VCM Editor is NOT supported by this 
device. This helps prevent the tuner's customers from 
altering the tuner's enhancements.

When used with the optional Pro Feature Set 
(including the Pro Link+), the RTD+  allows users to 
attach additional sensor inputs, which may provide 
valuable insight into what's going on under the hood.

In North America, The RTD+ is only available via direct 
sale to select, high volume tuning customers. Devices 
sold this way typically carry the tuner's company brand. 
They are not sold under the HP Tuners brand.
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MPVI2

This interface supports most of the features that the 
current generation of devices support.

However, the iOS version of the TDN app is 
NOT supported by this device. It also has less storage 

than the MPVI3 and lacks a high-resolution accel-
erometer.

When used with the optional Pro Feature Set , the 
MPVI2 also allows tuners to attach additional sensor 
inputs, which may provide valuable insight into what's 
going on under the hood. However, this device uses a 
Pro Link for this function rather than the Pro Link+ used 
by newer devices.

RTD

This is the first generation of our RTD series. These 
devices are for vehicle owners and vehicle technicians 
who are using a third party to tune vehicles rather than 
tuning vehicles themselves. 

NOTE: These devices are the same generation as 
the MPVI2. They're just intended for a different 
group of users.

First generation RTDs fully support the Android version 
of the TDN app, which is the recommended software 
for users of these devices. Users who are interested in 
the powerful data logging features of VCM Scanner will 
find that application to be fully functional with RTD as 
well. However, use of VCM Editor or the iOS version of 
the TDN app is NOT supported by this device.
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MPVI

The MPVI was the first HP Tuners interface device to 
connect to computers using a USB interface.

An enhanced version of this device, called the MPVI 
Pro, also supported attaching additional sensor 
inputs, which could provide valuable insight into what 
was going on under the hood. This function used an 
Enhanced Input/Output Connector (EIO Plug), which 
was only supported by the MPVI Pro. The EIO Plug 
could not be used with the standard MPVI interface.

NOTE: Use of this device with PCs running 
Windows 11 (or newer) is not supported. 

SERIAL INTERFACE

The original interface device provided by HP Tuners 
connected to the 9-pin RS-232 serial port that was usually 
present on laptops made at the time.

NOTE: Use of this device is no longer supported.
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OBTAINING A NEW INTERFACE DEVICE
You can purchase the latest HP Tuners interface device from our website. Upgrades to 
the current interface from older interface devices may also available.

NOTE: At the time of this writing , MPVI2+ is the current device. But, MPVI3 is 
coming soon!

PURCHASING AN INTERFACE DEVICE

1. Navigate to the current device's page on the HP Tuners website:

￭ MPVI2+: https://www.hptuners.com/mpvi2plus/

￭ MVPI3: : https://www.hptuners.com/mpvi3/

2. The Pro Feature Set is included with MPVI3 . If you wish to purchase a license for 
this feature with an MPVI2+, scroll down to the bottom of the page and check the 
PRO FEATURE SET LICENSE box.

NOTE: Although Pro Feature Set is included with MPVI3, the device does not 
come with a Pro Link+ cable. This must be purchased separately.

3. If you wish to load your device with credits immediately, select the number of 
credits to add.

NOTE: If you won't be flashing tunes to vehicles immediately, this can wait. 
Credits can be purchased at any time. See Adding Credits (Page 20).

4. Click Add To Cart and proceed to checkout.
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UPGRADING FROM OLDER INTERFACES

NOTE: Due to initial demand, updgrades to MPVI3 will not be available 
immediately. However, we expect them to become available shortly.

Upgrades to the current interface from older HP Tuners devices are usually available. 
Follow these steps to upgrade your older device to the current interface:

1. Backup the licenses and credits on your existing interface:

a. Connect the interface to a computer that has the VCM Suite installed.

b. Start VCM Editor and select  Help > Resync Interface from menu bar.

2. Navigate to the customer account page at https://www.hptuners.com/my-
account/ .

3. Select the My Devices tab. You will find this tab located in the sidebar on the left 
side of the screen.

Page 40

https://www.hptuners.com/my-account/
https://www.hptuners.com/my-account/


INTERFACE DEVICES

HP Tuners, LLC
700 Eastwood Lane
Buffalo Grove, IL 60089 , USA

4. Scroll down to the list of registered devices and select Upgrade next to the device 
you wish to upgrade.

5. Complete your order.

NOTE: If you are upgrading from MPVI2 Pro to MPVI2+, you will receive the Pro 
Feature Set free of charge. There is no need to purchase it again for the new 
interface.

6. Ship your old interface to the address below and include your order number on 
the outside of the box.

NOTE: This is an exchange. You will NOT receive your old device back.

SHIPPING ADDRESS

HP Tuners LLC

RE: Interface Upgrade

700 Eastwood Ln

Buffalo Grove, IL 60089
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WHAT IS PRO FEATURE SET?
The Pro Feature Set is an enhancement to MPVI2 and MPVI2+ that takes the capabilities 
of these interfaces to the next level. Pro Feature Set is standard on MPVI3 .

At present, purchasing the Pro Feature Set adds the following features: 

￭ Support for Pro Link and Pro Link+

￭ Standalone Data Logging

Additional features are planned.

PRO LINK AND PRO LINK+

The Pro Link and Pro Link+ are cables that allow additional inputs to be connected to 

the MPVI2 , 2+ and 3 for enhanced data logging. This allows you to see these additional 
signals in VCM Scanner, potentially providing critical insights into how your tune is 
performing.

￭ Pro Link allows you to connect up to two analog signals (such as a wideband sensor 

or a map senor) and one CAN bus signal to an MPVI2 .

￭ Pro Link+ allows you to connect the same inputs to an MPVI2+ or MPVI3 .

When you purchase the Pro Feature Set for your MPVI2/2+, we will send you the 
version of the Pro Link cable that supports your interface.

Although Pro Feature Set comes standard on the MPVI3 . The Pro Link+ cable must be 

purchased separately for this interface. To order, go to https://www.hp-
tuners.com/product/pro-link-plus/ .

STANDALONE DATA LOGGING

Standalone Data Logging lets you log directly to the internal storage on your MPVI2+  
without being tethered to a laptop. It is now easier than ever to collect data while 
driving. Easily record your vehicle’s data on the go with a press of a button or pre-set 
start/stop triggers. Then, at your convenience, evaluate and customize start/stop 
conditions right on your PC or laptop.
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PREPARING A NEW INTERFACE DEVICE FOR USE
After unboxing a brand new HP Tuners interface device, you will want to make sure it 
is up to date with all of the latest fi les and firmware. The following steps will help you 
get started with your device and will also allow you to resync to get the newest 
updates.

BEFORE YOU BEGIN

Ensure that:

￭ Your computer is connected to the Internet.

￭ The current version of the VCM Suite is installed.

UPDATING DEVICE DRIVERS

MPVI2+ / MPVI3

When used with a computer running Windows 10 (or later), the MPVI2+ and MPVI3 are 
completely "Plug and Play" devices. You do not need to manually update their drivers. 

If you are preparing an MPVI2+ or MPVI3 for use with a Windows 7 or 8 computer, 

contact Customer Support for setup instructions.

MPVI2

1. Navigate to https://www.hptuners.com/downloads/ .

2. Download the MPVI2 drivers.

3. Unzip and install the drivers on your computer. 
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SYNCING THE INTERFACE

1. Connect your MPVI2/2+ to your computer via the USB cable.

2. Open VCM Editor.

3. From the Help menu, select Resync Interface .

4. If the Sync was successful, the progress bar will indicate that the operation is 
complete.
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REGISTERING YOUR INTERFACE DEVICE
Before you can use a new MPVI2 , 2+, or 3 , you will need to register the device with HP 
Tuners. The following instructions will walk you through the registration process:

1. Make sure your computer is connected to the Internet.

2. Connect your MPVI2/2+/3 to your PC using the USB cable.

3. Open either VCM Scanner or VCM Editor.

4. In the menu bar, select Help > MPVI2 Verification Code .

5. Write down the serial number and verification ID that the VCM software gives you 
(or keep the window open for cutting and pasting).

6. If you do not already have an account with hptuners.com, create one now. See 
Creating An Account (Page 11).

7. Navigate to the customer account page at https://www.hptuners.com/my-
account/ .
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8. Select the My Devices tab on your account page. You will find this tab located in 
the sidebar on the left side of the screen.

9. In the fields under the MPVI2/MPVI2+ heading, enter the serial number and the 

verification ID you received in Step 4 .
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10.Click Import . A summary of the new device will appear below the fields you just 
fi l led out.

NOTE: If you have registered multiple devices, look for the new device's serial 
number in the column on the left.

This summary includes information about how many credits are already on the 
device (if any). It also indicates whether you have licensed the Pro Feature Set or 
the  User Defined Parameters feature for this device. You can use the links here to 
purchase any of the options listed.
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CONNECTING TO A VEHICLE
The procedure for connecting to a vehicle varies by the type of interface device you 
are using.

MPVI2/2+/3 AND ALL RTD INTERFACES
When used with the VCM Suite, a USB connection to your PC is recommended:

1. Connect the larger end of the included USB cable to an available USB port on a 
laptop with VCM Suite Installed. 

2. Connect the other end of the USB cable to the USB type C port on the front of the 
interface device.

 

3. When you are ready to scan or reprogram the vehicle, plug the large, molded OBD-
II connector on the other side of the interface device into the vehicle's diagnostic 
port.

When used with the TDN app for mobile devices, these devices connect to your 
mobile via Bluetooth® . The app provides on-screen instructions for establishing the 
connection and attaching the device to your vehicle. For more information, consult 
the documentation for the TDN app.
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MPVI
1. Connect the larger end of the included USB cable to an available USB port on a 

laptop with VCM Suite Installed. 

2. Connect the other end of the USB cable to the USB type B port on the interface 
device.

3. Connect the 15-pin side of the OBD-II interface cable to the matching connector on 
the interface device.

4. When you are ready to scan or reprogram the vehicle, connect the 16-pin side of 
the OBD-II interface cable to the vehicle's diagnostic port.

MANUFACTURER LOCKED CONTROL MODULES
Some vehicle manufacturers now put locking devices in their VCMs to prevent third 
parties from tuning the vehicle. Although most of these vehicles can be read by the 
VCM Suite without any problem, writing an updated tune to these vehicles may 
require special hardware.

For many of these vehicles, HP Tuners can upgrade the existing VCM to allow it to be 
tuned by our software or exchange it for a controller that has already been upgraded. 
For other vehicles, a special cable may be required.
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GM

Controller Vehicles
HP Tuners 
Solutions

E41 ECM

2017+ Chevrolet Silverado 
and GMC Sierra 2500/3500 
trucks with 6.6L Duramax 
diesel engines

L5P purchase, 
exchange, or 
upgrade

E99 ECM 2019+ Corvette ZR1
ZR1 modified 
purchase or 
exchange

E90 ECM

2019 - 2021 Chevrolet 
Silverado and GCM Sierra 
trucks with 5.3L L84 engines 
and 6.2L L87 engines

L84 & L87 – E90 
modified ECM 
exchange

T87A TCM
2017+ GM vehicles equipped 
with 8-speed and 10-speed 
transmissions

T87A unlock 
service
Unlocked T87A 
purchase

DODGE / CHRYSLER / RAM / JEEP

Controller Vehicles
HP Tuners 
Solutions

2015+ PCMs
All 2015+ Dodge, Chrysler, 
RAM, and Jeep vehicles 
(except Dodge Viper)

Dodge PCM 
upgrade service

Dodge upgraded 
PCM purchase
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Controller Vehicles
HP Tuners 
Solutions

2018+ PCMs
All 2018+ Dodge, Chrysler, 
RAM, and Jeep vehicles.

Dodge 2018+ 
smart access 
cable
(These vehicles also 
require the 
upgraded PCM 
above)

POLARIS

Controller Vehicles
HP Tuners 
Solutions

MG1CA007 ECM RZR-Pro R
MG1CA007 ECM 
upgrade service

All supported 
ECMS

Supported Ranger, Ace, 
Sportsman, RZR, and 
Scrambler models

OBD-II adapter 
cable for Polaris 
vehicles
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READING AND CLEARING DTCS
When you begin tuning a new vehicle, ALWAYS check the vehicle for diagnostic trouble 
codes (DTCs)  and resolve as many as you can before you do anything else. If there is a 
mechanical issue with the vehicle, it may affect performance and any performance 
data you want to monitor could be impacted. This makes it very difficult to tune the 
vehicle effectively.

IMPORTANT: Reading a vehicle's current tune will clear all DTCs, resulting in the 
loss of the troubleshooting information they contain. DO NOT read the tune until 
you have checked for DTCs here and resolved or made note of any issues 
reported. 

Follow these steps:

1. Physically connect your laptop to the vehicle. See Connecting to a Vehicle (Page 
49).

2. If VCM Editor is open, close it now.

3. Open VCM Scanner.

4. Turn the vehicle ignition to a position other than OFF. (The engine can be running 
or stopped. But, the vehicle must supply power to the OBD-II port.)

5. Click the  icon in the toolbar to open a data connection to the vehicle.

6. Click  . The Diagnostics & Information window appears.
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7. Click Read DTCs . VCM Scanner will query the vehicle for diagnostic information. 
When finished, any DTCs detected will appear in the top half of the window.

8. Some vehicles report additional "freeze frame" data for individual DTCs. If this data 
is available for your vehicle, it can be viewed on the Freeze Frame tab.

9. Use the provided information to resolve as many issues as possible before tuning 
the vehicle.
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10. If desired, you can click Clear DTCs to tell the vehicle that the issue has been 
repaired.

NOTE: Clearing DTCs resets the emissions monitors. This will cause the vehicle 
to fail emissions testing until it completes the tests performed by the 
emissions monitors. These tests typically take several drive cycles to 
complete.

NOTE: If an issue has not been successfully repaired, a cleared DTC will be 
reported again.
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READING A VEHICLE
When you read a vehicle, you are transferring calibration information from the control 
module(s) in your vehicle to VCM Editor. The read process will automatically detect 
the presence of relevant VCMs in the vehicle and read them all in sequence. The 
various status messages and the progress bar give information about the current 
state of the read.

CAUTION: Ensure that the vehicle battery is charged before proceeding 
(keeping the battery attached to a charger during the procedure is 
recommended). Although it should not be possible to harm any of the 
vehicle's control modules during the read process, vehicle controllers can 
be left in an odd state if a power loss occurs.

If communication is lost, the program will automatically reset the module. It will then 
prompt you to correct the problem and/or try again.

READ PROCEDURE
To read the VCM, follow these steps:

1. Connect your HP Tuners interface device to a laptop with VCM Suite installed. 
Then, connect the device to the vehicle's OBD-II diagnostic port. See  Connecting to 
a Vehicle (Page 49) for more information.

2. If VCM Scanner is open, close it before proceeding.

3. Open VCM Editor.

4. If a tune file is open, close it by selecting File > Close in the menu bar.

5. Turn the vehicle ignition to the ON (or RUN) position, but do not start the engine.

NOTE: Some vehicles require special procedures to be put in the correct state. 
See Putting a Vehicle in the "ON" State (Page 58) for more information.

6. Make sure the doors are closed and all accessories are turned off. 
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CAUTION: Do not use any vehicle accessories, including the door locking 
mechanism, while the vehicle is being read.

7. In VCM Editor, select Flash > Read Vehicle . 

8. The Vehicle Reader window appears. Wait 10 to 15 seconds.

9. Click the Read button.

10.Allow VCM Editor to read the vehicle controllers until the status bar indicates the 
read is complete.

NOTE: During the read, the instrument panel may briefly display all sorts of 
indicators and error messages and some accessories may appear to turn on 
and off randomly. This is normal.
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NOTE: For vehicles with multiple VCMs (for example: LS2 A4 vehicles), there is 
a 15-second pause between reading each module.

11.Turn off the ignition and unplug the interface cable.

12.The file will automatically open in VCM Editor.

13. If this is the initial read of the stock controller, we strongly recommend that you 
save (and backup) the file before any modifications are made. You may wish to 
restore your vehicle to the stock tune at a later date.

PUTTING A VEHICLE IN THE "ON" STATE
When connecting to a vehicle for read and write operations, HP Tuners software 
typically requires that the vehicle be put in an ON state without starting the vehicle's 
engine. The correct procedure varies from model to model. Here are some examples:

CONVENTIONAL KEY START IGNITIONS

1. Insert the key in the ignition.

2. Rotate the key to the ON (or RUN) position, but do not continue to the 
START position.

DODGE / CHRYSLER / RAM / JEEP WITH RED PUSHBUTTON IGNITION

Keep your foot off the brake and follow these steps.

1. Press the red START button once. The indicator around the button will change 
from OFF to ACC.

2. Wait 2 seconds.

3. Press the red START button again. The indicator should change to RUN.

GM VEHICLES WITH PUSHBUTTON IGNITION

Without putting your foot on the brake pedal, push and hold the ENGINE START button 
for eight to ten seconds.
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CONTACTING CUSTOMER SUPPORT

OVERVIEW
HP Tuners does not currently offer incoming phone support. The best way to reach 

our Support Department is to create a ticket . If you prefer to speak with someone 
on the phone, just let us know in the ticket and we'll call you back as soon as possible.

When you contact us, we may ask for an infolog, a debug.dat fi le, or a license file. 
Having these files ready may speed up the support process.

HOW TO GENERATE A VCM SUITE INFOLOG
When contacting customer support, it 's often helpful for us to have a copy of a VCM 
Suite Infolog. The Infolog must be generated while connected to your vehicle.

GENERATING AN INFOLOG

1. Click the VCM Suite Info button in either VCM Editor or VCM Scanner.

NOTE: make sure your cable is connected to the vehicle and the vehicle's key is 
in the ON position before proceeding. 

2. Click the blue circle "i " icon to poll the software and the vehicle. 
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NOTE: This step may take five to twenty seconds to complete.

3. When Infolog generation is finished, click on the Save icon. Once the file is saved, it 
is ready to email to our Support team.
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LOCATING THE DEBUG.DAT AND LICENSE.DAT FILES
For many support issues, we ask that you provide us with a debug.dat fi le. This fi le can 

be found in This PC > Documents > HP Tuners > Settings :

We may also ask for a license.dat fi le. This can found in the same file path.
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